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1 Safety

1.1 Designated use

ControlCare is a field-based control system comprising hardware and software modules. It can be 

used to visualize, monitor and control production processes. The approved usage of the individual 

units used in the system can be taken from the corresponding parts of the operating instructions.

The software described in this particular manual allows a network connected to a ControlCare 

SFC162 FOUNDATION Fieldbus Field Controller to be engineered, configured and commissioned. 

In addition, appropriate control strategies can be built using the function blocks contained in the 

controller and connected devices.

1.2 Installation, commissioning and operation 

ControlCare Field Controllers have been designed to operate safely in accordance with current 

technical safety and EU directives. Essential to their use is the ControlCare Application Designer 

software suite, which allows control strategies to be created for FOUNDATION Fieldbus and 

PROFIBUS I/O applications. Field devices, links, junction boxes, cables and other hardware 

comprising the Fieldbus sytem must also be designed to operate safely in accordance with current 

technical safety and EU directives. 

If devices are installed incorrectly or used for applications for which they are not intended, or if the 

controller is not configured correctly, it is possible that dangers may arise. For this reason, the system 

must be installed, connected, configured, operated and maintained according to the instructions in 

this and the associated manuals: personnel must be authorised and suitably qualified.

1.3 Operational safety

Location ControlCare Field Controllers must be mounted in a permanent and weather-protected location in 

a safe area. The environment shall be a metal cabinet or an installation frame with a well grounded 

mounting plane. The environment shall be protected. 

Hazardous areas The controller must be connected to networks operating in explosion hazardous areas via barriers 

or other safety components. When installing components in explosion hazardous areas:

•  Ensure that all installion and maintenance personnel are suitably qualified

•  Check that all equipment has the appropriate safety certificates

•  Observe the specifications in the device certificates as well as national and local regulations.

This topic is discussed in BA013S (FOUNDATION Fieldbus Guidelines) and BA034S (PROFIBUS 

Guidelines).

EMC All modules are suitable for industrial use and conform with the following standard, see Appendix:

•  EN 61326: 1997/A1: 1998

Interference emmision: Class A apparatus

Interference immunity: as per Annex A, industrial environment

Depending upon the environment in which the bus is operating, particular attention should be paid 

to the grounding of the bus cables. This topic is discussed in BA013S (FOUNDATION Fieldbus 

Guidelines) and BA034S (PROFIBUS Guidelines).
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IP Address Field Controller is normally configured from a workstation connected into the control system 

backbone. You will require a unique IP address to set it up.

Warning

• The use of IP addresses is strictly controlled. Usually your system administrator will be authorised 

to allocate unique addresses. Assigning an unauthorised address to a Field Controller may result 

in conflicts within your system and the failure of the associated devices!

It is recommended that ControlCare Field Controllers and OPC servers are not installed in an office 

network, as the large data packets exchanged between office equipment may lead to timeouts and 

intermittent communication errors. Ideally, the ControlCare system network should operate within 

its own IP domain; if this is not possible it should be separated from other parts of the network by 

a managed switch.

Since the system can be accessed and manipulated through the various Field Contoller tools, it is 

advisable to control access both to the workstation and the folders in which the configuration is 

stored. Always make a back-up of the project.

Technical improvement Endress+Hauser reserves the right to make technical improvements to its software and equipment 

at any time and without prior notification. Where such improvements have no effect on the 

operation of the equipment, they are not documentated. If the improvements effect operation, a 

new version of the operating instructions is normally issued. 

1.4 Conventions and icons

In order to highlight safety relevant or alternative operating procedures in the manual, the following 

conventions have been used, each indicated by a corresponding icon in the margin. 

Safety conventions Icon Meaning

A note highlights actions or procedures which, if not performed correctly, may indirectly affect operation or 

may lead to an instrument response which is not planned

Caution!

Caution highlights actions or procedures which, if not performed correctly, may lead to personal injury or 

incorrect functioning of the instrument

Warning!

A warning highlights actions or procedures which, if not performed correctly, will lead to personal injury, a 

safety hazard or destruction of the instrument
Warnung!
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1.5 ControlCare documents

Table 1.1 indicates the documents, planned and realized, containing safety relevant information, 

installation, commissioning and operating instructions for the equipment and software associated 

with Field Controller.

All documentation available at the time of release is included on the ControlCare CD-ROM and is 

installed in Start=>Programs=>Endress+Hauser=ControlCare=Manuals during set-up.

Tab. 1-1: ControlCare Documentation

Component Description Document type Designation Order No.

System ControlCare System Overview Operating manual BA016S/04/en 56004883

ControlCare System Design Operating manual BA039S/04/en Planned

ControlCare System Specifications Operating manual BA040S/04/en 56004888

Software Application Designer Overview Operating manual BA017S/04/en 70104301

Application Designer: Local I/O Tutorial Operating manual BA032S/04/en 71095009

Application Designer: FF Tutorial Operating manual BA019S/04/en 70101151

Application Designer: PROFIBUS Tutorial Operating manual BA036S/04/en 70101152

Application Designer: MODBUS Tutorial Operating manual BA037S/04/en 70101153

Application Designer: IEC 61131-3 

Ladder Logic Tutorial 

Operating manual BA038S/04/en 70101386

Application Designer: IEC 61131-3

Structured Text Tutorial

Operating manual BA056S/04/en 71060063

Field Control (OPC) Servers Operating manual BA018S/04/en 71031428

SFC162 Visitor Operation manual BA069S/04/en 71113457

Field Controller Hardware Installation Guide Operating manual BA021S/04/en 56004885

Commissioning and Configuration Operating manual BA035S/04/en 56004887

Function Blocks Function Block Manual Operating manual BA022S/04/en 56004886

Set-Up Getting Started Operating manual BA020S/04/en 56004884

General FOUNDATION Fieldbus Guidelines Operating manual BA013S/04/en 70100707

PROFIBUS Guidelines Operating manual BA034S/04/en 56004242
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2 Task Description

This tutorial describes all steps necessary for setting up the project described below. It does not aim 

to give an exhaustive account of Application Designer functions, but rather shows you one of a 

number of methods to reach your goal. The tags and names used in the tutorial are imaginary and 

will be different in a proper application. A full description of Application Designer functions is to be 

found in Application Designer Overview BA017S/04/en and Drawing Tool BA032S/04/en. 

Function block descriptions are to be found in BA022/04/en, Function Block manual.

2.1 Application

For this tutorial, the case of cascade control for a heat exchanger will be used, see Fig. 2-1. 

Fig. 2-1:  Schemetic diagram of heat exchanger application

A liquid flows through the heat exchanger and is heated by condensing steam. The controlled 

variable is the exit temperature of the liquid flowing through the exchanger. The manipulated 

variable is the steam flow to the exchanger. The temperature of the product defines the set point of 

the steam flow, which is controlled by a valve in order to avoid excessive waste of energy (=steam). 

The example illustrated Control in the field: the corresponding control strategy is shown in Fig. 2-2.

Fig. 2-2  Cascade control strategy for heat exchanger application
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2.2 Network

The network is assumed to be constructed as shown in Fig. 2-3. 

•  The flowmeter is a Promass 83F, suitable for steam measurement

•  The valve positioner is a Metso ND9103FN with control capability

•  The temperature transmitter TMT162

All devices are equipped with a FOUNDATION Fieldbus H1 interface.

Fig. 2-3  Network for application example

As shown in Figure 2-2, the control will be done in the TMT162 temperature transmitter and the 

ND9103FN valve positioner. As far as traffic on the bus is concerned, this is the most efficient 

method. The user has, however, the alternative of performing all control in the SFC162 Field 

Controller, should this be preferred. 

High Speed Ethernet
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2.3 Preliminaries

2.3.1 Installation and commissioning

Before you can start the FOUNDATION Fieldbus tutorial, Application Designer must be installed on 

your computer, the SFC162 Field Controller installed and commissioned and a connection made to 

your computer. Instructions on how to do this are to be found in:

•  Operating Instructions BA020S/04/en, Getting Started

•  Operating Instructions BA021S/04/en, Field Controller: Hardware Installion

•  Operating Instructions BA035S/04/en, Field Controller: Commissioning and Configuration

2.3.2 Device ID and tag

For a FOUNDATION Fieldbus system, each device that communicates has a unique bus address. 

Addresses are assigned automatically during the start-up of the system on the basis of the device ID. 

The device ID is a unique identifier that is based on a Manufacturer ID, device type and the serial 

number of the device. When the project goes online, the actual device IDs must be assigned to 

virtual devices that have been planned in Application Designer by using the Assign Tags procedure. 

To aid the offline engineering of the network, it is necessary to keep a record of the measuring point 

tags (device tags), often as an Excel sheet. Measuring point tags are used in P&I diagrams to indicate 

the type of measurement or action performed at a particular location in a process. Table 2-1 below 

provides an example of how this might look for the application at hand.

Tab. 2-1: Measuring point tag list for tutorial application

Area Process Cell Device Vendor Tag Unit Task

Pasteurization Heat Exchanger TMT162 E+H TT100

TT100-

PID

°C Product temperature

Temperature PID

Pasteurization Heat Exchanger Promass 83F E+H FT101 t/h Steam flow

Pasteurization Heat Exchanger ND9103FN Metso FCV102

FCV102-

PID

% Steam valve positioner

Flow PID

Pasteurization Heat Exchanger SFC162 E+H CO104 Controller
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3 Create a FOUNDATION Fieldbus Network

3.1 Create a FF project

1 Start ControlCare Application Designer by clicking on the icon on your destop or via Start => 

Programs => Endress+Hauser => ControlCare => ControlCare Application Designer

2 The project starts from a blank application screen

– With the right mouse key select Project File=>New

1 The Document Type box appears: Click the option Project

2 The New Project dialog box opens:

1. Choose the folder where the project will be saved.

2. Type the name of the project in the File Name box.

3. Click Save. 

If the new project is not to be created, click Cancel.

3 ControlCare Application Designer automatically creates a folder with the entered file name 

within the selected folder.
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3.2 Determine the naming preferences

Before you start, you can set preferences for the way your project is created. Of particular interest 

at this stage is the labelling of the function blocks.

1 Press Project File => Preferences

– The Preferences Dialog appears

Tag Policy Tag Policy determines how the blocks are labelled by default if no tag names are entered

1 Select the folder Block and the subfolder Tag Policy, then check the following buttons

– Device

– Update Block Tag

2 Press OK to confirm your selection

– Application Designer will now automatically rename any blocks created in the control

strategy window as they are assigned to the devices by adding the device tag as prefix.

Tag Composition Tag Composition determines how the block identifiers are added to the block tag if no block name 

is entered.

1 Select the subfolder Tag Composition:

– Enter a mnemonic separator: for this manual the setting was "-"

Default setting is "_" and mandatory for if flexible function blocks are to be used

– Check Prefix

2 Press OK to confirm your selection

– Application Designer will now automatically compose the blocks according to your

selection, e.g. TagName-Block-n or TagName_Block_n.

Export Tag Export Tag causes tags to be automatically exported every time the project goes online

1 Select the subfolder Export Tag

– Check the Automatic button

– Press OK to confirm your selection

Strategy Strategy determines the default shape of the function block icons in the stratagy window and also 

whether the aliasing function is enabled

1 Select the subfolder Strategy

– Select the default shape for function block objects

– Select "Aliasing Input Dialog Box" if you want to use your own input and output labels 

in the strategy 

– Press OK to confirm your selection
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3.3 Add a bridge (SFC162)

1 On saving, ControlCare Application Designer automatically creates a project, adding the HSE 

fieldbus network and the HSE Host

– Click on + to expand the tree:

2 Now right-click on the HSE Network leaf and select New=>Bridge

3 The New Bridge dialog box appears:

Select the SFC162 Field Controller and type in a device TAG, in our case CO104

If you do not type in a tag, the default will be "Bridge n", where n is a consecutive number. 

4 Press OK to create the Bridge.

5 Repeat Steps 1 to 4 for as many SFC162 Field Controllers as you have in your network.
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3.4 Add a fieldbus segment

1 The project now looks like this:

2 Right click on the bridge you just created, here "CO104", and select New Fieldbus.

3 The New Fieldbus dialog box appears:

– Enter a Fieldbus TAG, 

– Select the fieldbus port on the SFC162

– If you do not type in a tag, the default will be "Fieldbus n", where n is a consecutive number. 

4 Press OK to create the Fieldbus.

5 Open Project File, then press Save, to save the project.

6 Repeat Steps 1 to 5 for as many fieldbus segments as are in use.
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3.5 Add the devices

1 Click on the newly created Fieldbus 1 leaf and select Expand

2 A new work space Fieldbus 1 opens:

– Right-click on the Fieldbus 1 leaf and select New then Device

3 The New Device dialog appears

– Select the Device Manufacturer = Endress+Hauser

– Select the Device Type = TMT162

– Enter the Device Tag = TT100

If you do not type in a tag, the default will be "Device n", where n is a consecutive number 

– Press OK to create the device

Note! 

• Application Designer follows the latest DD and CF revisions by default. 

• If you are working with devices with older DD and CF revisions, uncheck the checkbox and select 

the correct Device Revision. 
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4 Your project now looks like this:

5 Repeat Steps 2 and 3 for the Promass 83 and the ND9103FN positioner

– Promass 83:

Manufacturer = Endress+Hauser

Device Type = Promass83

Device Tag = FT101

– ND9103FN:

Manufacturer = Metso Automation

Device Type = Metso FBLK Interface

Device Tag = FCV102

6 Your project should now look like this:

7 Open Project File, then press Save, to save the project.
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3.6 Export tags

Note! 

• You should use the Export Tags function everytime you change the configuration of the project, 

so that the OPC server information is always up-to-date.

• Application Designer can be set up to automatically export tags everytime the system goes online, 

see Chapter 3.2

1 Active the project view by clicking in its workspace

2 Right click on the project name, a context menu appears

3 Select the option Export Tags...

– The Export Tags dialog confirms the successful export

– Press OK to close the dialog

4 Open Project File, then press Save, to save the project



4 Create a Control Strategy ControlCare Application Designer: FOUNDATION Fieldbus Tutorial

16 Endress+Hauser

4 Create a Control Strategy

Having created a physical view of the process, the next step is to create control strategy. This is done 

in the logical view of the plant. This represents the plant as Areas/Process Cells in accordance with 

ISA S88/IEC 61518.

4.1 Add a Process Cell

1 Click on the "Area 1" leaf in the project and select Attributes...

2 The Attributes dialog box appears

– Enter a name for the area, e.g. Pasteurization (see Table 2-1, Chapter 2.3)

– Click OK to store your changes

3 Click on the Area leaf again and select New Process Cell...

4 The Process Cell dialog box appears

– Enter a name for the process cell, e.g. Heat Exchanger (see Table 2-1, Chapter 2.3)

– Click OK to store your changes

5 Open Project File, then press Save Entire Configuration, to save the project.
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4.2 Add a Control Module

1 Right-click on the Process Cell leaf you just created and select Expand

1 A new window with the name of the leaf opens

– Right-click on the top leaf and select New Control Module

2 The Control Module dialog box appears

– Enter a name for the control module, e.g. Temperature Control (see Table 2-1, Chapter 2.3)

– Click OK to store your changes

3 The project now looks something like this:

4 For a real project, Step 2 and 3 would be repeated until all the required control modules for a 

particular process cell have been added.

– A Control Module (with all blocks and links) can be copied and then pasted to the 

Process Cell by selecting the appropriate contect menu or using CTRL + C and CTRL +V

5 Open Project File, then press Save Entire Configuration, to save the project.
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4.3 Create the function blocks

Note! 

• The function blocks used in the tutorial are selected from the device manufacturer’s device list. 

It is also possible to select standard function blocks from the "Fieldbus Foundation" list. This 

ensures that the control strategy can be executed in any device that supports a particular standard 

block, irrespective of vendor.

• Endress+Hauser devices support standard function blocks and offer them in the manufacturer 

specific list.

1 Double-click on the control module leaf or right-click and select Strategy to open the Control 

Strategy workspace - this has the same name as the leaf

2 Press the Function Block button  in the toolbar and click in the workspace

– The New Block dialog appears

– Select the Manufacturer = Endress+Hauser

– Select the Device Type = TMT162

– Select the Block Type = Analog Input

– Press OK to create the function block

3 The block now appears in the strategy window with the default name
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4 Repeat Steps 2 and 3 for the Temperature PID, Flow AI, Flow PID and Valve AO blocks

– Temperature PID: 

Manufacturer = Endress+Hauser

Device Type = TMT162

Block Type = PID Control

– Flow AI

Manufacturer = Endress+Hauser

Device Type = Promass83

Block Type = Analog Input*

– Flow PID

Manufacturer = Metso Automation

Device Type = FBLK Interface

Block Type = PID Control

– Positioner AO

Manufacturer = Metso Automation

Device Type = FBLK Interface

Block Type = Analog Output

5 The control strategy now looks like this

6 Open Project File, then press Save Entire Configuration, to save the project.

°Note! 

• The Promass 83 offers seven Analog Input blocks because it supports exactly this number. 

• It does not matter which you select, the process value offered by each is determined by the 

channel setting, see Chapter 5.
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4.4 Add the Function Block Links

1 In the Control Strategy workspace position the blocks according to your strategy

– The blocks can be dragged and dropped by selecting and holding down the right mouse key

– The blocks can be aligned by selecting, then via Tools => Alignment => e.g. Middle 

followed by a click on the block to which the alignment is to be made

– The Tools menu also contains other standard drawing functions such as toolbars, standard 

shapes, line thickness, colours etc.

2 Click on Function Block Link  button in the tool bar, the cursor changes to a cross

– Select the Temperature AI block with the cross: the Output Parameter Selection

dialog appears

3 Click the box next to OUT – it changes color – then click on OK

– The Output Parameter Selection dialog closes

– The cursor is now connected to a blue dotted line

– Place the Cursor in the Controller PID Block 1 and click to make the link
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4 When the link is made, the Input Parameter Selection dialog for the PID block appears

– Click the box next to IN – it changes color – then click on OK

5 If the Aliasing Input dialog box is enabled, see Chapter 3.2, the Rename dialog now appears 

– Enter the desired link name and press OK

– If nothing is entered, the link retains the standard name

6 When the Input Parameter Selection dialog changes, the link is made and appears as below:

– The link appears as a dotted line because the function block has yet to be attached to a device 

– You may have to move the parameter legends "IN" and "OUT" by selecting and positioning 

with the left mouse key depressed

7 Repeat steps 2 to 5 and make the following links between the function blocks

– PID1 and PID2 = OUT to CAS_IN

– PID2 and PID1 = BKCAL_OUT to BKCAL_IN

– Flow AI to PID2 = OUT to IN

– PID2 to Valve AO = OUT to CAS_IN

– Valve AO to PID2 = BKCAL_OUT to BKCAL_IN

8 Your Control Strategy now looks something like this

9 Open Project File, then press Save Entire Configuration, to save the project.
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4.5 Configure the strategy

FOUNDATION Fieldbus offers the possibility of storing complete control strategies as fully 

configured generic templates. This is especially useful when particular control strategies occur 

several times within a project. The strategies are stored independent of device assignment, which is 

performed as a separate step, see Chapter 4.7.

In this tutorial, the strategy will be configured to receive the incoming process values from the input 

blocks as % of full range, and to output a % value to the positioner. 

4.5.1 Analog Input parameters

The function blocks Temperature control- AI-1 and Temperature control-AI-2, for the 

TMT162 and Promass respectively, have to be configured. The basic parameters required are shown 

in Table 4-1. A full description of the parameters are to be found in the Operating Instructions

•  BA224REN for TMT162

•  BA065DEN for Promass 83F

Tab. 4-1: Basic parameters for Analog Input blocks

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 4-1 (the same order in which they are 

displayed in the Off Line Characterization dialog. 

After characterization of the block, the parameters will appear in the FOUNDATION Fieldbus tree. 

If you find a parameter in the wrong position, it can be move by dragging and dropping to the correct 

one. 

Parameter Function Temperature 

TC100

Flow 

FC101

MODE BLOCK/TARGET Normal operating mode of block Auto Auto

XD_SCALE/EU_100*

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range value for process variable

Lower range value for process variable

Unit of process variable

150 (max.850)

–50 (min. –200)

°C

18 

0 

t/h (unit)

OUT_SCALE/EU_100

OUT_SCALE/EU_0

OUT_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

100

0

%

CHANNEL Output channels of Transducer Block aasigned 

to Ananlog Input Block.

• TMT = Primary, RJ or Sensor vlaue 1/2 

depending on whether one or two sensors 

are connected

• Promass = 1 to 7, depending on which type 

of process value is required

Sensor Value 1 1 = mass flow

L_TYPE Selects the type of linearisation for the input 

value.

• Direct: PV value = OUT value, 

Identical XD_SCALE and OUT_SCALE

• Indirect: PV value scaled to OUT value

• Indirect Square Root: as Indirect but scaling 

with root function

Indirect Indirect

PV_FTIME Output damping constant (in seconds). 1 1

*The range limits for the TMT162 temperature transmitter are determined by the transducer block parameters 

SENSOR_TYPE and PRIMARY_OUTPUT_TYPE. For SENSOR_TYPE = Pt100 and PRIMARY_OUTPUT_TYPE = SV_1 the 

transducer block outputs a temperature signal in the range -200°C to +850°C. The XD_SCALE and OUT_SCALE 

parameters generate the OUT value of the Anlaog Input block from any part of this range, in our case -50°C to 150°C. 
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4.5.2 Characterize the Analog Input blocks

1 In the Control strategy workspace, double-click on the Temperature control AI-1 block

– The Off Line Characterization dialog opens

– Press All to display all the parameters

2 The Mode Block Target must be set to Auto.

– Expand the Mode Block parameter tree

– Double-click on the "Value space" next to the Target parameter

– Select "Auto" from the drop-down menu

– Press End Edit to register your change

3 Repeat this procedure for the remainder of the Temperature parameters in Table 4-1

– Remember to press End Edit after every change

– When all parameters have been entered, press Close to quit the Characterization dialog

4 Repeat Steps 1 to 3 for the Flow parameters in the Temperature control-AI-2 block

5 Open Project File, then press Save Entire Configuration, to save the project.
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4.5.3 Basic PID parameters

The Field Controller PID blocks must now be characterized. In practice, the values for the GAIN, 

RESET and RATE as well as the setpoint value SP for the temperature loop will be known. The other 

values determine the way the control is handled when the block moves from auto/cas or a process 

value has a bad status. See also ControlCare Function Block manual BA022S/04/en.

Tab. 4-2: Basic parameters for temperature and flow PID blocks

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 4-2 (the same order in which they are 

displayed in the Off Line Characterization dialog. 

After characterization of the block, the parameters will appear in the FOUNDATION Fieldbus tree. 

If you find a parameter in the wrong position, it can be move by dragging and dropping to the correct 

one. 

Parameter Function Temperature 

TC100

Flow 

FC101

MODE BLOCK/TARGET Normal operating mode of block Auto CAS

SP/VALUE Setpoint for product temperature 40% –

PV_SCALE/EU_100

PV_SCALE/EU_0

PV_SCALE/UNITS_INDEX

Upper range limit for process variable

Lower range limit for process variable

Unit of process variable

100

0

%

100

0

%

OUTSCALE/EU_100

OUTSCALE/EU_0

OUTSCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

100

0

%

CONTROL_OPTS Sets control options for bad input Bypass Enable Bypass Enable

BYPASS When ON, SP value is transferred to the OUT 

without the calculation of PID terms. 

OFF OFF

SP_RATE_DN

SP_RATE_UP

Rate of change from old to new, higher SP

Rate of change from old to new, lower SP

0

0

0

0

GAIN

RESET

RATE

Tuning constants for the P, I and D terms, of 

the PID block respectively.

1.5

0.1

0.5

2

0.2

0.6

SHED_OPT Behaviour when shedding from remote mode Normal shed, 

normal return 

Normal shed, 

normal return 
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4.5.4 Characterize the PID blocks

1 In the Control strategy workspace, double-click on the Temperature control PID-1 block

– The Off Line Characterization dialog opens

– Press All to display all the parameters

2 The Mode Block Target must be set to Auto.

– Expand the Mode Block parameter tree

– Double-click on the "Value space" next to the Target parameter

– Select "Auto" from the drop-down menu

– Press End Edit to register your change

3 Repeat this procedure for the remainder of the Temperature PID parameters in Table 4-2

– Remember to press End Edit after each entry

– When all parameters have been entered, press Close to quit the Characterization dialog

4 Repeat Steps 1 to 3 for the Flow PID parameters in the Temperature control-PID-2 block

– Remember to set the Block Mode Target to CAS 

5 Open Project File, then press Save Entire Configuration, to save the project.
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4.5.5 Analog Output parameters

The function block Temperature control- AO-1 for the ND9103FN now has to be configured. 

The basic parameters required are shown in Table 4-3. A full description of the parameters are to 

be found in the Operating Instructions

•  ND9000F Users Guide, downloadable from www.metso.com

Tab. 4-3: Basic parameters for Analog Output block

4.5.6 Characterize the Analog Output block

1 In the Control strategy workspace, double-click on the Temperature control AO-1 block

– The Off Line Characterization dialog opens

– Press All to display all the parameters

2 The Mode Block Target must be set to Cas.

– Expand the Mode Block parameter tree

– Double-click on the "Value space" next to the Target parameter

– Select "Cas" from the drop-down menu

– Press End Edit to register your change

3 Repeat this procedure for the remainder of the Temperature AO parameters in Table 4-3

– Remember to press End Edit after each entry

4 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Positioner 

FCV102

MODE BLOCK/TARGET Normal operating mode of block Cas

PV_SCALE/EU_100

PV_SCALE/EU_0

PV_SCALE/UNITS_INDEX

Upper range limit for process variable

Lower range limit for process variable

Unit of process variable

100

0

%

XD_SCALE/EU_100

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

CHANNEL Defines the signal configuration between the AO block and 

transducer block..

• 1 = AO, valve control

• 2 = AO, no transducer connected

1 = valve control

SHED_OPT Behaviour when shedding from remote mode Normal shed, normal 

return 
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4.6 Store the strategy as a template

After configuration, the strategy can be stored as a template for similar applications using the same 

devices.

1 In the Strategy workspace, drag the mouse across the complete strategy with the lefthand 

button depressed, until all function blocks are selected

2 Now press the Strategy Export button  in the toolbar

– The Save As dialog appears

– If appropriate, browse to another folder

– Enter a File Name

– Press Save to save the strategy

3 The strategy can be imported again pressing the Strategy Import button  in the toolbar and 

double-clicking on the appropriate file name.
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4.7 Assign the Function Blocks to the Devices

Now assign the function blocks in the control strategy to the devices where they are to run. The 

order of assignation determines the order of executions (can be changed by drag&drop).

1 Expand the Fieldbus workspace (Fieldbus 1) and the Process Cell workspace (Heat 

exchanger) 

– Note that the Heat Exchanger tree now contains all the function blocks that you created in 

the Control Strategy workspace

2 Now drag and drop the Temperature control-AI-1 block to the greyed Function Block 

Application leaf of the TT100 tree

– When you drop the block, it is attached to tree

– Its name changes to TT100-AI-1 in both views

– You have now assigned the Temperature AI block to the temperature transmitter

3 Repeat Step 2 for the other function blocks

– Temperature control-PID-1 => TT100

– Temperature control-AI-2 => FT101

– Temperature control-PID-2 => FCV102

– Temperature control-AO-1 => FCV102

4 Your project now looks like this

5 Click on the Project View workspace and Export Tags..., see Chapter 3.5

6 Open Project File, then press Save Entire Configuration, to save the project.
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5 Parameter the Devices

It is important to remember that the device parameters in the Transducer Block are an integral part 

of any FOUNDATION Fieldbus project. This has consequences in the way the devices can be 

parametered. There are three options:

•  Off-line configuration in Application Designer for later download to the devices

•  On-line configuration in FieldCare via DTMs for later upload into Application Designer

•  Bench mode configuration with a handheld or at a local device interface, e.g. display, 

for later upload into Application Designer

Option 1 is available for all blocks and devices contained in the Application Designer 

FOUNDATION fieldbus library and would be normal practice. 

Options 2 and 3 are available for all device transducer blocks with the exception of the Field 

Controller hardware configuration block. A description of how to configure using FieldCare and 

how to upload the parameters into the controller and Application Designer is to be found in 

Operating Instructions BA069S/04/en, whereby the SFC162 does not have to be switched to 

visitor mode. The upload function is available from Version 2.05.xx upwards.

This tutorial tells you how to parametrize offline with Application Designer.

5.1 TMT162 temperature transmitter

Full details of how to parametrize the TMT162 temperature transmitter are to be found Operating 

Instructions BA224REN.

5.1.1 Transducer Block

Table 5-1 shows the parameters that must be set in the TMT162 TEMP_1 transducer block

Tab. 5-1: Basic parameters for TMT162 transducer block

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 5-1 (the same order in which they are 

displayed in the Off Line Characterization dialog. 

After parametrization of the block, the parameters will appear in the FOUNDATION Fieldbus tree. 

If you find a parameter in the wrong position, it can be move by dragging and dropping to the correct 

one.

Parameter Function Temperature 

TT100

MODE BLOCK/TARGET Normal operating mode of block Auto

PRIMARY_VALUE_TYPE Calculation method for primary process value

• Process temperature SV1 or SV2

• Average 0.5 (SV1 + SV2) with/without redundancay

• Differential (SV1 - SV2)

• Conditional (SV1 or SV2), (SV2 if SV1 >T)

Sensor Value 1

SENSOR_TYPE Type of sensor connected to the transmitter

• All types of standardized temperature sensors

Pt 100 IEC 751

SENSOR_CONNECTION Way in which the sensor is connected

• 4-wire (if two sensors are connected only one can be 4-wire)

• 3-wire

• 2-wire

2-wire
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5.1.2 Parameter the transducer block

1 In the Fieldbus network workspace, expand the TT100 tree until the function blocks are visible

– Right click on the TT100-TEMP-1 block and select Off Line Characterization...

(for some revisions the block is named TT100-BLK-1)

2 The Off Line Characterization dialog opens

– Expand the Mode Block parameter tree

3 The Mode Block Target must be set to Auto. If this is not the case

– Double-click on the "Value space" next to the Target parameter

– Select "Auto" from the drop-down menu

– Press End Edit to register your change

4 Now set the following parameters to the values in Table 5-1:

– PRIMARY_VALUE_TYPE = PV = Sensor value 1 (SV1)

– SENSOR_TYPE = Pt 100 IEC (a=3.85 E-03)

– SENSOR_CONNECTION = 2-wire

5 Press Close to quit the Characterization dialog

6 Click on the Project View workspace and Export Tags..., see Chapter 3.5

7 Open Project File, then press Save Entire Configuration, to save the project.
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5.2 Promass 83F flow transmitter

Full details of how to parametrize the Promass 83F flow transmitter are to be found Operating 

Instructions BA065DEN.

5.2.1 Transducer Block

In the tutorial, we have selected Channel 1 in the FT101-AI-2 block, which means that the 

transducer block must be configured to deliver mass flow in the selected units (t/h). The parameters 

used correspond to those in the Gas Flow Quick Setup in Chapter 6.3 of the Operating Instructions. 

Table 5-1 shows the parameters that must be set in the Promass 83F transducer block

Tab. 5-2: Basic parameters for Promass 83F transducer block

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 5-2 (the same order in which they are 

displayed in the Off Line Characterization dialog. 

After parametrization of the block, the parameters will appear in the FOUNDATION Fieldbus tree. 

If you find a parameter in the wrong position, it can be move by dragging and dropping to the correct 

one. 

Parameter Function Flow 

FT101

MODE BLOCK/TARGET Normal operating mode of block Auto

SYSTEM_UNIT_MASS_FLOW Engineering unit of the mass flow measurement

• Select from drop-down menu

t/h

LOW_FLOW_CUT_OFF_ASSIGN Assigns the low-flow cut-off function to a particular 

measurement

• Select from drop-down menu

Off

EPD_EMPTY_PIPE_DETECTION Enables or disables Empty Pipe Detection function Off
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5.2.2 Parameter the transducer block

1 In the Fieldbus network workspace, expand the FT101 tree until the function blocks are visible

– Right click on the FT101-TRD-1 block and select Off Line Characterization...

(for some revisions the block is named FT101-BLK-1)

2 The Off Line Characterization dialog opens

– Expand the Mode Block parameter tree

3 The Mode Block Target must be set to Auto. If this is not the case

– Double-click on the "Value space" next to the Target parameter

– Select "Auto" from the drop-down menu

– Press End Edit to register your change

4 Now set the following parameters to the values in Table 5-2:

– SYSTEM_UNIT_MASS_FLOW = t/h

– LOW_FLOW_CUT_OFF_ASSIGN = Off

– EPD_EMPTY_PIPE_DETECTION = Off

5 Press Close to quit the Characterization dialog

6 Click on the Project View workspace and Export Tags..., see Chapter 3.5

7 Open Project File, then press Save Entire Configuration, to save the project.
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5.3 Metso ND9103FN positioner

Full details of how to parametrize the Metso ND9103FN valve positioner are to be found in the 

ND900F User Guide which can be downloaded from www.metso.com.

5.3.1 Transducer Block

In the tutorial, you have probably only the valve positioner, but not the valve itself. In real life, the 

positioner must be told what it is driving and certain assembly information must always be entered 

into the transducer block. The for a rotary valve parameters are included in Table 5-3. For 

instructions on how all other parameters can be used, see the User Guide. 

Tab. 5-3: Basic parameters for Promass 83F transducer block

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 5-3 (the same order in which they are 

displayed in the Off Line Characterization dialog. 

After parametrization of the block, the parameters will appear in the FOUNDATION Fieldbus tree. 

If you find a parameter in the wrong position, it can be move by dragging and dropping to the correct 

one.

Parameter Function Positionere 

FCV102

MODE BLOCK/TARGET Normal operating mode of block Auto

VALVE_TYPE Type of valve the positioner is actuating

• Select from drop-down menu

Rotary

FINAL_VALUE_RATE_DN Maximum travel rate in closing direction

• 0 = parameter not in use

0

FINAL_VALUE_RATE_UP Maximum travel rate in opening direction

• 0 = parameter no in use

0

POSITIONER_FAIL_ACTION Action of position on loss of electrical power or reception of an 

output signal with a bad status

• Select from drop-down menu

Close

POS_SENSOR_ROT Relationship between valve action and position sensor rotation

• Select from drop-down menu

Standard: 

Clockwise to close

DEAD_ANGLE_COMP Dead angle for segment and rotary valves 0

ACT_TYPE Type of positioner action 

• Select from drop-down menu

Double-acting 

actuator

PERFORMANCE_LEVEL Target performance level of valve position control

Select from drop-down menu

Optimum

CHAR_TYPE Type of linearization

• Select from drop-down menu

No characterization
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5.3.2 Parameter the transducer block

1 In the Fieldbus network workspace, expand the FCV102 tree until the function blocks are 

visible

– Right click on the FCV102-BLK-2 block and select Off Line Characterization...

2 The Off Line Characterization dialog opens

– Expand the Mode Block parameter tree

3 The Mode Block Target must be set to Auto. If this is not the case

– Double-click on the "Value space" next to the Target parameter

– Select "Auto" from the drop-down menu

– Press End Edit to register your change

4 Now set the following parameters to the values in Table 5-3:

– VALVE_TYPE = Rotary

– POSITIONER_FAIL_ACTION = Close

– ACT_TYPE = Double-acting actuator

5 Press Close to quit the Characterization dialog

6 Click on the Project View workspace and Export Tags..., see Chapter 3.5

7 Open Project File, then press Save Entire Configuration, to save the project.
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6 Go On-line

6.1 Connect to the Field Controller

In order to download the project, the host computer and Field Controllers must be allocated 

IP addresses in the same address range. It is possible to do this on the workbench before installation 

or after the Field Controller and other components have been physically installed in the Fieldbus 

network (subnet). 

Warning

• The use of IP addresses is strictly controlled. Usually your system administrator will be authorised 

to allocate unique addresses. Assigning an unauthorised address to a Field Controller may result 

in conflicts within your system and the failure of the associated devices!

Note!

• The tools that setup the network use Ethernet services that may be blocked by Windows Firewall. 

Normally the firewall will be unblocked for the tools during installation, but it might be necessary 

to stop the firewall should they not function properly. If you are not sure how to stop the firewall, 

consult your system administrator.

Before starting, check the following:

•  Internet Protocol TCP/IP is installed on your computer

•  You have administration rights for your computer

•  You have an set of IP addresses that have been authorized by your IT department

•  Any proxy server for your Internet Browser is disabled

The procedures described in this chapter are for Windows XP. For other Windows systems consult 

your system administrator.

Note!

• When the Field Controllers are physically connected together with the Host computer via 

Ethernet, HSE Network Setup will see the them irrespective of the IP address domain to which 

they belong
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6.1.1 Set the IP address of the host computer

SFC162 Field Controllers are delivered with the default IP address:

•  192.168.164.100 

In order that the host computer can communicate with the Field Controller Web Server, it must be 

allocated an IP address in the same address domain, e.g. 192.168.164.200. If you are not sure how 

to do this, consult your network administrator. 

Procedure 1 Right-click Start =>Settings =>Control Panel =>Network Connections

2 Right-click Local Area Connection => Properties

3 Using the left mouse button, double-click Internet Protocol (TCP/IP) or

click once, then click Properties. 

4 Note the original values of IP address and Subnet Mask of the computer to restore them if 

necessary at end of the operation. 
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5 Change the IP address and the Subnet Mask of the host computer to those required by the 

application. In the example, an address in the same subnet as the Field Controller. 

– IP Address 192.168.164.XXX and network mask (Subnet Mask) 255.255.255.0.

– Do not use the address 192.168.164.100,as these are reserved as default addresses for 

Field Controller SFC162

6 Click on the OK button to complete the procedure, close the other dialogs with OK and 

Close.

6.1.2 Set the Field Controller IP address

Note!

• It is recommended that Field Controllers of the same type are introduced one by one to the 

network.

1 Call HSE Network Setup: 

Programs =>Endress+Hauser=>ControlCare=>Tools=>HSE Network Setup

2 HSE Network Setup is launched and searches for Field Controllers in the Ethernet network.

– All Field Controllers in the network appear, irrespective of their IP domain. 

If this is not the case:

– Check that the proxy server of your Internet Browser is switched off

– Check that the windows firewall is not blocking the program (switch off)

– Check all cables and switches

– If you find two or more Field Controllers with the same IP address, disconnect all but one 

from the network

3 If your computer has more than on NIC card, select the one you want to use for 

communication with the Field Controllers by ticking "Active NIC" and Press .
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4 Right-click on the Field Controller, the address of which is to be changed:

the Field Controller Web Server opens

– The Web Server will only open if the host computer and the Field Controller have 

IP addresses in the same IP domain.

5 Expand the Setup node and click Network

– Enter User Name "pcps" and Password "pcps" to open the Network Configuration dialog

– Enter the required IP address, in our example 10.125.35.180

– Enter a netmask, normally 255.255.255.0

– If required, enter a default gateway, usually address xxx.xxx.xxx.1 in the selected domain

6 Press Update to change the IP address

– You are now asked to restart the Field Controller

– Select the Restart node

– Select "No additional options" from the drop-down menu and press Restart

– Close the Web Browser

– The Field Controller disappears from HSE Network Setup and reappears with the new 

IP address
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7 Now set the address of he host computer to the same domain as the Field Controllers, see 

Chapter 6.1.1 - in our example 10.125.35.200

– Restart HSE Network Setup

– Tick the Field Controller, so that it appears in the HSE Live List associated with the 

computer’s active NIC card.

– Press  to save the configuration.

– You are now ready to download the project

Note!

• If you have more than one Field Controller on the network, Repeat Steps 4 to 6 for all other Field 

Controllers, introducing them one by one to the network.
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6.2 Create a live list

6.2.1 Create the HSE live list

Once the Computer and Field Controller are able to communicate with each other, the connection 

to the network can be checked by creating a live list. 

1 Press the On-Line button  in the menu toolbar

– The project goes on on-line

– Red crosses appear against the Field Controller in the Project workspace and against the Field 

Controller and devices in the Fieldbus network workspace

2 In the Project workspace, right click on HSE Network and select Live List

– A live list is generated of the devices on the HSE network

Note! 

• It may take sometime to generate the live list 

– The devices found first go grey 

– Their profiles (all important device-specific data) including IP address are read 

– On successful completion of profile reading, the devices are shown in full black
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6.2.2 Assign the HSE Device IDs

1 In the Project workspace, right click on the Field Controller (CO104) and select Attributes...

2 The Attributes dialog opens

– Open the drop-down menu of the Device ID and select the Field Controller associated

with the displayed TAG (in our case CO104) - the serial number is on the front panel

– Do this even though the correct ID is already displayed - the program expects it!

– Confirm your choice with OK

– If Application Designer detects a mismatch in version, this is logged at the bottom of the page

(for remedy, see Chapter 7.2)

3 In the HSE Live list, the Controller Icon goes grey, then reappears with the correct tag

4 If several SFC162s were in use, Steps 1 and 4 would be repeated for all.

5 Click on the Project View workspace and Export Tags..., see Chapter 3.10

– Open Project File, then press Save Entire Configuration, to save the project.
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6.2.3 Create the FOUNDATION Fieldbus live list

1 In the Fieldbus network workspace, right-click on Fieldbus 1 and select the option Live List

2 The Fieldbus live list is created

– Check that devices in the project appear in the live list. If not, check connections etc.

6.2.4 Assign the Fieldbus Device IDs

1 In the fieldbus workspace, right click on TT100 and select Attributes...

2 The Attributes dialog opens

– Open the drop-down menu of the Device ID and select the device ID associated

with the displayed TAG (in our case TT100) - the serial number is on the nameplatel

– Confirm your choice with OK

– After a period of time, the red cross disappears from the device in the Fieldbus network

– If Application Designer detects a mismatch in version, this is logged at the bottom of the page

(for remedy, see Chapter 7.2)

3 Repeat the process for the rest of the devices in the Fieldbus network (FT101, FCV102)

– After a period of time, the red cross disappears from the device in the Fieldbus network

4 Click on the Project View workspace and Export Tags..., see Chapter 3.10

– Open Project File, then press Save Entire Configuration, to save the project.
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6.2.5 Assign All Tags

1 In the Fieldbus workspace, right-click on the Fieldbus node at the top of the tree and select 

Assign All Tags

2 The Assign All Tags dialog appears with the list of device and a progress bar

– On completion, the message "Profile reading done" stands next to the Field Controller

and "Tag has been confirmed" next to the devices

– If there are any failures in tag assignment these are logged with reasons at the bottom of the 

screen.

3 As the assignment proceeds, the Field Controller transmits the change to the device

– The device goes grey in the live list

– The Field Controller initiates a new network scan

– After about 1 - 2 minutes, the device goes black and appears with the new tag

4 At the end of the process the live list looks like this

– The "bright" dot next to the SFC162 Field Controller indicates that it is the ACTIVE LAS 

of this segment
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6.3 Download the project

Note! 

• The procedure below describes the initial download for the entire HSE network. 

• Partial downloads can be made later from lower leaves, when changes are confined to this level

• Incremental downloads can be made to a running project by checking the boxes Incremental 

Download and Compare Parameters: Unaffected Local I/Os will hold their last values.

6.3.1 Download

When the devices in the Fieldbus live list correspond to those configured in the project, the 

download can begin.

1 In the Project workspace right-click on HSE Network and select Download

2 The Download dialog appears

– Press Start to start the download

– A log at the bottom of the screen allows you to identify and non-critical download problems

3 The download will be interrupted if the project encounters a critial problem, e.g.

– The Project tags are not up-to-date => Chapter 3.10

– The Device IDs have not been assigned correctly => Chapter 6.2.2, Chapter 6.2.4

– The Device Tags have not been assigned => Chapter 6.2.5

4 When the download is successfully completed, the dialog is closed, and you are ready to test 

the control strategy
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6.3.2 Configure device class

In our project the Field Controller acts as the Link Active Scheduler by default. The FOUNDATION 

fieldbus protocol allows other devices to take over the this role should the Field Controller fail. This 

ensures that any control loop not involving function blocks in the controller will continue to 

function in this event. A device can be setup to be a backup LAS by using the Configure Device Class 

function. This function is only effective when the device is online.

Note!

• If you are offline, the process finishes at Step 2. The change is registered in the project but is not 

downloaded with it. The procedure must then be repeated with the device online, otherwise a 

mismatch when you try to download. 

Procedure 1 In the Fieldbus window, right click on the Fieldbus node to open the context menu

– Select the menu Configure Device Class

2 The Device Class dialog opens

– Select the device(s) you want as backup LAS 

(usually one with few FB links, in our case TT100)

– Press >> to transfer the device to the righthand pane

(if the device does not support LAS functionality, an error message appears)

– Press Apply to confirm the choice and close the dialog.

3 When online, the Change Device Class dialog appears and shows the download progress

4 On completion the TT100 device appears in the live list with a dot indicating backup LAS 

functionality
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6.4 Check the control stategy

1 Click in the Control Strategy workspace (Temperature control) and press the button  in the 

menu toolbar – the control strategy goes "on-line"

– Values appear in green when the status is good

– Values appear in red if the status is bad - at this stage this is an indication of a Fieldbus 

configuration, a strategy configuration or a device parametrization error

2 Check that the loop is working by changing the Setpoint parameter in the temperature PID 

TT100

– Double-click on the Temperature PID block TT100-PID-1, the On-line 

Characterization dialog appears

– Press the All icon to reveal all parameters

– Open the SP leaf and double-click in the space next to Value

– Enter a new SP value – for T > SP, set SP < T or vice versa

– Click End Edit to set the parameter

– Press Close to store the value (if you are prompted - answer with Yes)

3 Now check that the control loop has responded properly
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6.5 Modify the project

Note! 

• It is essential that any change in the project, in particular to device settings, is registered in 

Application Designer, as this serves as a back-up in the event that the Field Controller battery 

becomes empty. This is the assured, provided the procedures described in this Chapter are 

followed.

6.5.1 On-line characterization

Once the project is on-line you may want to change parameters to e.g. tune the control-loop or 

eliminate configuration errors. With the exception of the SP parameter, the function block must be 

put out of service before the parameter is changed:

1 In the Control strategy workspace double-click on the function block you want to modify, or in 

the Fieldbus network or Control module workspace, right-click on the function block and 

select On Line Characterization

2 The function block On Line Characterization dialog appears:

– Press the All icon to reveal all parameters

– Open the Mode leaf and double-click in the space next to Target

– Set the Target to OOS (Out of Service)

– Click End Edit to set the parameter

3 Change the parameters you wish to modify

– If appropriate, open the parameter leaf and double-click in the space next to the parameter 

you require

– Enter the new parameter or select it from the drop-down menu

– Click End Edit to set the parameter

– Repeat the procedure for all the parameters you wish to modify

4 Put the function block back into standard operating mode

– Open the Mode leaf and double-click in the space next to Target

– Set the Target back to the original value (Auto (Automatic) or Cas (Cascade))

– Click End Edit to set the parameter

– Check that the Mode really changes to the Target Mode (failure to do so indicates a 

configuration error)

– Press Close to store the values (if you are prompted - answer with Yes)

5 Click on the Project View workspace and Export Tags..., see Chapter 3.10

– Open Project File, then press Save Entire Configuration, to save the project.

6 Put the Control stategy back "on-line" to check the results of your modification, Chapter 6.4.
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6.5.2 Off-line characterization

You may prefer to change parameters off-line, e.g. when modifying the control strategy or adding 

new functions to the project. 

1 If you are on-line, press the Off-line button  in the menu toolbar

alternatively, in the FOUNDATION Fieldbus network or Control module workspace, right-

click on the function block and select Off-line Characterization

– The function block Off-line Characterization dialog appears

2 Change the parameters you wish to modify

– If appropriate, open the parameter leaf and double-click in the space next to the parameter 

you require

– Enter the new parameter or select it from the drop-down menu

– Click End Edit to set the parameter

– Repeat the procedure for all the parameters you wish to modify

– Press Close to store the values

3 Click on the Project View workspace and Export Tags..., see Chapter 3.10

– Open Project File, then press Save Entire Configuration, to save the project.

4 Press the On-line button  in the menu toolbar to go on-line again

5 Download the modified project

– In the Project workspace right-click on Fieldbus Network and select Download

– Follow the procedure in Chapter 6.3

6 Put the Control stategy back "on-line" to check the results of your modification, Chapter 6.4.

6.5.3 Handheld, FieldCare or local interface

If device parameters are changed with a handheld, FieldCare or at a local interface, e.g. display, the 

changes must be uploaded to the Field Controller and Application Designer. The upload function is 

available from Version 2.05.xx upwards. Depending upon the tool and the task this can be done for 

the entire fieldbus or for individual devices.

1 Open Application Designer and go online

2 Right click on the Fieldbus1 node in the fieldbus pane and select Upload...

– Answer the confirmation dialog with Yes

3 When the upload is complete, click on the plant node and select Export Tags

4 Now check the transducer blocks to see whether the upload was successful

– Open the Online Characterization block to view the parameters

– Put the control strategy on line to check that it is working

5 Open Project File, then press Save Entire Configuration, to save the project.
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6.6 Packing and unpacking the project

In order to install the project at the customer’s site, the project can be packed and unpacked. It is 

important to remember, especially if you have not been using the actual project devices to test your 

project, that the instruments on site may be have newer (or even older) DD/CFF files than the ones 

you use. The latest DD/CFF files must then be uploaded to the project and corresponding 

corrections must be made to configuration, before it is downloaded to the SFC162 Field Controller, 

see Chapter 7.2.

6.6.1 Pack the project

1 Select Project File => Pack Project...

– The Pack Project dialog appears

– Browse to the folder where the files will be created

You can create a folder with the Make New Folder button 

– Enter the name of the project

– Press Save to save the packed project

– Press OK to close the successful packing message dialog

6.6.2 Unpack the project

1 Select Project File => Unpack Project...

– In the Unpack Project dialog

– Browse to the folder where the packed project is located

– Click on the name of the project

– Press Open to save the packed project

2 In the Browse for Folder dialog:

– Browse to the folder where the project is to be installed

You can create a folder with the Make New Folder button 

– Press OK to start upacking

– Press OK to acknowledge the successful unpacking of the project

6.6.3 Unpack the OPC data base only

For some applications it may be necessary to update the OPC data base of a SCADA program that 

has no provision for importing new DDs etc.. This can be done in Application Designer, which 

allows the separate unpacking of the OPC data base.

1 Go online, then right-click on the HSE OPC Server icon in the system tray

2 Select Unpack Configuration...

– Unpack the OPC data base to the folder required according to the Steps 1 and 2 in

Chapter 6.6.2 above
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6.7 Export the configuration

For documentation purposes, the project configuration can be exported to an existing ODBC file 

data source, e.g. Oracle, a machine database, e.g. Excel to provide a record of the current status of 

the project or to an XML sheet for viewing with a browser.

6.7.1 File data source folder

The file data source must have been created before the export.

1 In the Project window, right-click on the Project icon and select Export Configuration:

2 The Select Data Source dialog box appears

3 In the File Data Source folder, select the source that describes the driver that you wish to 

connect to. You can use any file data source that refers to an ODBC driver which is installed on 

your machine.

– Use the New... button and Look In dropdown menu to browse or 

– Click the data source icon to select the driver:

– Press OK to make the connection
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6.7.2 Machine data source folder

The Machine Data Source is specific to the machine, and cannot be shared. "User" data sources 

are specific to a user on the machine; "System" data sources can be used by all users on the machine, 

or by a system-wide service. The Machine Data Source must have been created before export.

Procedure 1 In the Project window, right-click on the Project icon and select Export Configuration:

2 The Select Data Source dialog box appears

– Click on the Machine Data Source tab to open the folder

– Double-click the data source name to select the machine, e.g. Excel:

3 The Select Workbook dialog box will appear:

– Select the folder where the data file is and double-click the workbook icon.

– Your project configuration will be exported to the workbook file.

– A message box appears on completion - press OK

4 Open the Excel file to check the result:
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6.7.3 XML file

1 Click in the Project workspace and select Project File => Export => Configuration as XML

– The Export Configuration as XML dialog appears

2 Enter a File Name and Save In location, then press Save

– The project is saved as an XML file at the selected location
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6.8 Close Application Designer

When you have completed your session, close Application Designer

1 If you are on-line, press the Off-line button  in the menu toolbar

2 If you have made any modifications while you were on line, you will be prompted to store 

them

– If appropriate answer with Yes

3 Close the project by clicking on Project File => Close

4 Exit Application Designer by clicking on Project File => Exit

5 The Field Controller continues to operate with the project configured according to the last 

download/on-line correction

– If you switch off the Field Controller, the project remains stored in its memory

(provided the battery DIP switch is on, see BA021S/04/en: Field Controller, Hardware 

Installation)

– It is initialized and re-executed as soon as the Field Controller is switched on again

6.8.1 Reconnecting

Provided your computer is operating in the same IP address domain as the Field Controller, you can 

reconnect at any time.

1 Start up Application Designer and select the Project you require

2 Press the On-line button  in the menu toolbar

3 Expand the various workplaces as required

4 Click in the Control Strategy workspace and press the button  in the menu toolbar – the 

control strategy goes "on-line" with the last configuration that was downloaded.
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7 Trouble-Shooting

7.1 Factory initialisation and reset

Warning!

• Do not use the pushbuttons located in the Field Controller unless you are certain that you want 

to reset the system.

Two pushbuttons located in the SFC162 module (and SFC173 module), see Fig 7.1, allow the 

system to be initialised and reset. The function and effect of the buttons is described in the table 

below.

•  To "click " the pushbuttons use a pointed instrument (e.g. a ballpoint pen). 

Other functions of the two buttons are to be found Chapter 7 of the Operating Instructions 

BA035S/04/en, Field Controller: Commissioning and Configuration..

Function Effect Procedure

Reset Resets system: the last 

configured IP Address 

is retained

• Click the right pushbutton - the system resets (takes several seconds)

• If no IP Address is found, a new one is assigned automatically

• Verify that the RUN and ETH LNK LEDs are lit.

Factory Init Deletes application, 

the last configured IP 

Address is retained

• Keeping the left pushbutton pressed, click the right pushbutton

• Check that the FORCE LED flashes once a second. 

• Release the left push button. The system resets, see above.
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7.2 Exchanging devices

It may be that during Device ID assignment, see Chapters 6.2.2 and 6.2.4, Application Designer 

detects a revision mismatch. If this occurs, the device revision must be changed in the project and 

the project downloaded as described below. 

Note! 

• For exchange of controllers, see Chapter 7.3, Updating the Firmware, in BA035S/04/en

• The process also applies to exchange of devices of the same type but different device revision

• In the case of devices from different manufacturers, manually check the incompatibilities (press 

NO at Step 3). Additional adjustments to the strategy may also be required.

• Device revisions not supported by Application Designer can be downloaded from 

www.fieldbus.org and integrated using the Import Device Support function

Procedure 1 Open the project in Application Designer and select the device to be updated, here SFC162

– Right-click on the node and select Exchange...

2 The Exchange dialog for the device appears

– Open the Device Rev menu and select the correct revision

– Press OK to confirm the change and close the dialog.

3 The Incompatibilities dialog may now appear

– Press OK to automatically update all links

– Close the successful exchange dialog by pressing OK.

4 Export the tags, press  to go on-line and download the project as described in Chapter 6.3.
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7.3 Trouble-shooting tables

7.3.1 Field Controller 

Problem Remedy

1 HSE Network Setup/FC Tools does not find any 

Field Controller

• Disable the Windows firewall (normally a message 

appears ask whether you should unblock the program)

• Disable the proxy server for your Internet browser

• Check that you are using the correct Ethernet cables, 

see ETH LINK below

• Check that all etehrnet switches are powered up

• Check that the network adapter is on and OK: Execute a 

PING command to its own IP, via DOS PROMPT.

• Check if the Ethernet connection is OK: Execute a PING 

command to the Field Controller.

2 Field Controller appears intermittently in FC Tools Host and Field Controller are in different subnets.

• Normal behaviour, but for firmware download both host 

and Field Controller must be in the same subnet

3 HSE Network Setup/FC Tools does not show all the 

Field Controllers that are in the network

There is probably an IP address conflict in the network.

• Disconnect all the Field Controllers except one from the 

from the sub-network

• If necessary, change its IP address

• Now reconnect the other Field Controllers one after the 

other, if necessary changing their IP addresses

4 Field Controller Web Server does not open No Ethernet connection

• Disable the Windows firewall

• Disable the proxy server for your Internet browse

• Wrong subnet IP address

Host and Field Controller must be in same subnet

• Wrong subnet mask

Host and Field Controller must have same subnet mask

5 Firmware begins to execute but after a certain time it 

stops

It might be a configuration problem. 

• Use the Factory Init procedure and configure the Field 

Controller again. 

• If the problem persists, see the relevant chapter in 

Operating Instructions BA035S/04/en, Field Controller, 

Commissioning and Configuration

6 HOLD LED remains lit If the HOLD LED remains lit after the Field Controller has 

been turned on, the firmware may be invalid. 

• Update the firmware, see the relevant chapter in 

Operating Instructions BA035S/04/en, Field Controller, 

Commissioning and Configuration

7 ETH LNK LED does not light Check if the cable is connected correctly, or that the cable is 

not damaged. Check the specification of the cables:

• SFC954 - Cable Standard.  To be used in a network 

between the Field Controller and a Switch/Hub.

(preferred configuration)

• SFC955 - Crossed Cable (Cross).  To be used point to 

point between a PC and the Field Controller

(some PCs/laptops may have problems with crossed 

cable)

8 FRC LED is flashing (Force) Field Controller is powered up for the first time

• Battery is not switched on (see BA021S/04/en, p50)

Field Controller is in reset mode

• Complete the RESET procedure

Field Controller is in normal operation

• Battery is flat: 

– No problem if controller remains powered up

– If power is switched off, the project will be lost and 

must be downloaded again from Application Designer 

on repowering
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7.3.2 Application Designer

Problem Remedy

1 Field Controller does not appear in HSE live list No connection to Field Controller

• See Remedies for Items 1, 2 and 4, Chapter 7.3.1

• Field Controller is on HOLD, set it to RUN mode

• IP address is not configured correctly, use PING to check

2 Field Controller appears but always stays grey in HSE 

Live List

No connection to Field Controller

• Check that host and Field Controller are in same subnet

3 Red cross appears on the Field Controller No communication with Field Controller

• No Ethernet connection with Field Controller, 

check connection, IP address etc, see above

• No Device ID set in the Field Controller (Attributes)

4 Red cross appears on Fieldbus/Profibus No communication with fieldbus/Profibus

• No communicaton with Field Controller, see above

• Fieldbus/Profibus not connected to controller

5 Red cross appears on field device No communication with fieldbus device

• No communicaton with Field Controller, see above

• No communicaton with fieldbus, see above

• No Device ID set (Attributes)

• Tag not assigned (Assign Tag)

6 A device does not appear in the live list Communication error

• The device is not powered up

• The project has been updated but no download has been 

made yet

7 Configuration will not download You have either a communication problem or the 

configuration is not complete

• Check that you are on-line - press the On-line button

• Check that your computer is in the same address subnet

• Check that you have assigned the Field Controller tag

• Check that you have exported all tags OPC server

• Check that the parameters are in the recommended order

• Check that the OPC server is running (look for icon in 

bottom line)

• Try "Update" from the Field Controller node and 

download again

9 Parameter appears red in the on-line control strategy The parameter has a bad status

• Check that the Block Mode is Auto (or Cas)

• Check that the block has been correctly configured

• Check that the device is still live (live list)

• Check that the device address is the same as that you 

have in your configuration (live list)

• Check that the parameter has been correctly configured

• Check that the tags were exported (Export Tags)

10 FB links do not work Project not downloaded correctly, e.g. partial download 

when bridge has HSE links

• Repeat full download from the HSE Network node
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For your notes
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For your notes
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